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Abstract 

SAS® OnDemand for Academics (ODA) provides students, faculty, and SAS learners with free access to SAS software and the 

SAS® Studio user interface using a web browser. SAS Studio provides a comprehensive and customizable integrated 

development environment (IDE) for all SAS users. To showcase SAS Studio’s many features, numerous techniques will be 

introduced to access, clean, transform, analyze, and visualize data using the point-and-click features found in SAS Studio’s 

Navigation Pane’s Tasks and Utilities. Plus, we’ll demonstrate the generated SAS code that is automatically produced from the 

point-and-click techniques. To obtain a high-level understanding of the datasets being used, we’ll demonstrate tasks associated 

with exploratory data analysis (EDA) to identify missing values, explore outliers, and evaluate trends in the data. Two types of 

regression will be demonstrated – simple linear regression where one independent variable is used to explain or predict the 

outcome of the dependent variable and multiple linear regression where two or more independent variables to explain or 

predict the outcome of the dependent variable to assist with decision-making activities. Key takeaways will be provided to 

assist in learning regression analysis techniques using effective examples. 

 

Introduction 

SAS® OnDemand for Academics (ODA) can be freely used by students, faculty, and anyone who wants to learn how to use SAS 

software. With SAS ODA’s cloud-based user interface, SAS Studio, users can access data and perform amazing extract, 

transform, and load (ETL) activities, data analysis, statistical analysis, reporting and data visualization, and other processing 

using SAS ODA with a common web browser. This paper introduces exploratory data analysis (EDA), data cleaning, data 

transformation, and regression analysis techniques using SAS ODA and SAS Studio’s powerful point-and-click user interface; the 

Navigation Pane consisting of Files and Folders, Tasks and Utilities, and Libraries; the SAS Programmer window; data access for 

accessing and retrieving data from SAS (SAS7BDAT) datasets; predefined tasks and utilities to perform exploratory data analysis 

(EDA) techniques to understand missing data, data anomalies, and trends in data; and perform regression analysis to help with 

decision-making activities, allocate resources more efficiently, identify the factors (or variables) that matter most and which can 

be ignored, and turning the collected data into actionable insights. 

 

Datasets Used in the Examples 
The example datasets and data files used in this paper include the Heart and Heart_MedCenter data files and SAS datasets. (For 

a thorough explanation of the step-by-step point-and-click operations associated with accessing and reading different types of 

data files (e.g., TSV, CSV, XLSX, JSON, and SAS7BDAT). The Heart and Heart_MedCenter datasets were presented in an earlier 

paper called, Data Access Made Easy Using SAS® Studio. 

 

File Type Definition 

SAS Dataset 

(SAS7BDAT) 

A proprietary SAS (SAS7BDAT) data format that contains data values that are created, organized, 
and stored as a table of rows and columns in a SAS library (e.g., WORK, SASUSER, and User-
assigned) where processing is performed by SAS software. 

 

https://www.lexjansen.com/pharmasug/2023/SD/PharmaSUG-2023-SD-072.pdf
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HEART_MEDCENTER Data Files and SAS Dataset 

( 5 Rows and 5 Variables ) 

 
 

HEART Data Files and SAS Dataset 

( 5,209 Rows and 18 Variables ) 

 
 

 

SAS Studio – A Cloud-based Integrated Development Environment (IDE) 

SAS OnDemand for Academics (ODA) provides learners and educators with a comprehensive cloud- and web-based user 

interface called SAS Studio. SAS Studio provides numerous user-friendly features to help users become more productive while 

using the SAS ODA. To begin, open one of the supported web browsers (e.g., Google Chrome, Mozilla Firefox or Apple Safari) to 

access SAS ODA by clicking the following hyperlink, https://www.sas.com/en_us/software/on-demand-for-academics.html, and 

then clicking the “Access Now” as shown, below. 

 

 

 

https://www.sas.com/en_us/software/on-demand-for-academics.html
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Step 1 – Create a SAS Profile 

The SAS OnDemand for Academics (ODA) Sign In dialog window will display as shown, below.  Before accessing SAS ODA, you 

will need to create a SAS Profile.  If you are already a SAS user and have set up a SAS profile account, then you can proceed to 

register to use SAS ODA. By entering your SAS Profile email address or user ID along with your Password in the designated 

boxes. If you are a new SAS user or have never created a SAS Profile then you will need to click the “Don’t have a SAS Profile?” 

hyperlink shown, below. 

 

 

After entering the requested information to create your SAS Profile, a message will display on your screen, below. 

 

 

 

Step 2 – Register to Use SAS OnDemand for Academics (ODA) 

After successfully creating a SAS Profile, you can register to use SAS OnDemand for Academics (ODA). You should then return to 

the SAS OnDemand for Academics (ODA) page where you will be prompted to select your home region and click Submit. A 

confirmation page will then appear like the one shown below, allowing you to finalize the process by clicking the Exit button. 

SAS will also send a follow-up email with your User ID so you can then enter this User ID or email address to access SAS ODA 

and SAS Studio software. 
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Signing Into SAS OnDemand for Academics (ODA) and Accessing SAS 

Studio  

After successfully registering to use SAS OnDemand for Academics (ODA), you can then sign in with your User ID and password 
credentials in the appropriate fields, check the box associated with accepting the terms of the license and the terms of use and 
conditions, and click the Sign In button as shown, below. 

 

 

 

The SAS ODA dashboard will then display with important information about your account including permissions, enrollments, 
courses, self-help references, and storage space quotas. When ready, click the SAS Studio hyperlink shown, below. 

 

 

 

 

SAS Studio User Interface 

SAS Studio’s powerful and easy-to-use interface provides users with a comprehensive integrated development environment 

(IDE). The SAS Studio interface is divided into several parts that help make user interaction easier, Navigation pane, and Work 

area more convenient. Let’s explore the different parts of SAS Studio to better understand what they’re used for. After signing 

into SAS Studio, Server Files and Folders provide users with the ability to upload local data files. There are four more dropdown 

menus below Server Files and Folders, two of which will be emphasized, Tasks and Utilities, and Libraries. 
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Navigation Pane 
When clicking on the Navigation pane’s drop-down arrow next to Tasks, more options expand as shown, below. SAS Studio’s 

built-in point-and-click interface helps make working with SAS datasets, text-delimited data files, CSV data files, Excel data files, 

JSON data files, and program code easier with a powerful toolkit of predefined tasks that enable users to list table attributes, 

characterize data, identify missing data and outliers, transform datasets using merge/join and transpose processes, perform 

data analytics, and several other tasks. 

 

Another Navigation Pane drop-down is Libraries. A SAS library is a collection of one or more SAS datasets that are stored, 

referenced, and processed by SAS software. Specifically, the SASHELP library stores a variety of SAS-supplied datasets for use by 

students, faculty, and SAS learners to explore and learn from. We will demonstrate using a modified version of the SASHELP 

library HEART dataset along with a user-created HEART_MEDCENTER dataset in several examples in this paper. 
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Program Window: Code, Log, and Results 
The SAS Studio Program window provides users with Code, Log, and Results tabs. A description of each tab appears below. 

 

Code Editor Tab 

SAS Studio includes a color-coded, syntax-checking editor for editing new or existing SAS programs. The editor includes a wide 

variety of features such as autocompletion, automatic formatting, and pop-up syntax help. With the code editor, you can write, 

run, and save SAS programs. 

 

There are a variety of icons in the Code tab toolbar. Most of these icons will display tooltips or their functionality when 

hovering the mouse on them. Below are descriptions of some commonly used SAS Studio-specific icons: 

 

Icon Tooltip Execution 

 
Run all or selected codes Executes all lines or highlighted lines of codes in the Code window. 

 Submission history 
Displays a history of executed statements and will rerun the code once 

selected on the previous statement.  

 Save program Save all codes.  

 
Program summary 

An HTML file that opens in a separate browser tab includes information about 

the program execution, the complete SAS source code, the complete SAS log, 

and the results. 

 
Clear all code Clears all code in the current program’s code editor. 

 

Log Tab 

It is crucial to develop a routine habit of checking the Log tab after each code execution as it is a tremendous tool for helping 

users during troubleshooting. After executing the program code, the SAS Log tab provides useful information about Errors, 

Warnings, and Notes in corresponding red, yellow, and blue colors. 

 

 
 

Results Tab 

By clicking the Results tab, you can view any output results from output-producing procedures. SAS software automatically 

produces HyperText Markup Language (HTML) results as the “default” output format, along with any graphical, tabular, and 

statistical information when it be requested, as shown, below. 
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Temporary versus Permanent SAS Datasets 

In the SAS world, the location of your data is everything. This concept is essential for SAS users to understand when using SAS 

OnDemand for Academics (ODA), or any other SAS product. But what does it mean? Data can be stored on a variety of fixed or 

removable storage devices including CDs, DVDs, Blu-ray, USB flash drives, tape, external hard drives, NAS storage, and in the 

cloud. The data access demonstrations presented in this paper use data that is stored in the cloud. 

 

Another important concept that users should become familiar with is which SAS library a dataset is stored in. The library where 

a SAS dataset is stored determines if the dataset is temporary or permanent. If this sounds a bit confusing, then the good news 

is that, in time and with practice, your comfort level working with temporary and permanent datasets will become easier with 

use. The SAS WORK library is classified as temporary, and all temporary SAS datasets are automatically removed (or deleted) at 

the end of a SAS session. A SAS dataset that is stored in either the SASUSER library or in a user-defined folder in SAS Studio is 

classified as permanent and, as a result, is accessible after the end of a SAS session, from one session to another, or until the 

SAS dataset is removed (or deleted). 

 

 

 

SAS Studio’s Point-and-Click Navigation 

SAS Studio’s point-and-click navigation provides users with a powerful, flexible, and easy to use approach to auto-generating 

SAS code for all types of SAS processing. The objective of this paper is to demonstrate the many capabilities that SAS 

OnDemand for Academics (ODA) and SAS Studio offers users including creating new SAS libraries; establishing library references 

(LIBREFs); uploading SAS datasets, tab-delimited, CSV, and Excel data files in the cloud; importing tab-delimited, CSV, and Excel 

data files to SAS datasets using tasks and utilities; and producing results using the Navigation pane. 

 

Assigning a New SAS Library 

Using the Navigation pane’s point-and-click features, select Libraries → New Library icon → Import Data to Using the 

Navigation pane’s point-and-click features, users can assign a new SAS library, a libref, and the path to where the data is in the 

cloud, as shown, below. 
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User-assigned library references (LIBREFs) along with their specific paths were specified using the New Library window. 

Specifically, the LIBREF, MYDATA, along with its path to identify where the Heart and Heart_MedCenter datasets are stored in 

the cloud are assigned, as shown, below. 

 

 

 
 

 
 

 

The Extract, Transform, and Load (ETL) Process 

The extract, transform, and load (ETL) process involves moving / migrating data from various sources into a data warehouse. 

The best way to understand how ETL works is to examine what happens in each phase of the process. The ETL process and its 

three phases are displayed in the figure below. 
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  Phase 1   Phase 2           Phase 3 

 ( Data Extraction / Retrieval )      ( Data Transformation )  ( Load ) 

 

 

Data Extraction / Retrieval Phase 

The first phase of the ETL process involves data extraction / retrieval from various sources (e.g., SAS datasets; text data files 

including tab-separated value (TSV) and comma-separated values (CSV); Excel; JavaScript Object Notation (JSON) data files and 

SAS datasets; legacy systems (e.g., ISAM, VSAM, etc.); web scraping; RDBMS tables (e.g., Oracle, SQL-Server, Teradata, DB2, 

MYSQL, etc.); cloud-based repositories; and other data file management systems. Specifically, the objective of the data 

extraction / retrieval phase is to access and extract the desired data from the various into a consistent and usable format 

enabling successful data transformation. 

 

Task: Uploading SAS Datasets and Other Data Files to the Cloud 

To upload SAS datasets and data files to SAS Studio in the cloud, the following point-and-click steps can be followed, as shown, 

below. In step #1, click the desired folder / sub-folder where you want a SAS dataset or data file uploaded to. In step #2, click 

the Upload control tool to display the Upload Files window. Then, click the Choose Files button, as shown, below. 
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After clicking the Choose Files button, navigate to where your data is stored (step #1), and then select the SAS dataset you want 

to upload (step #2), as shown below. 

 

 
 

After selecting the SAS dataset from the list of data files you want uploaded to the cloud, the Upload Files window will then 

display the name of the selected dataset. Finally, clicking the Upload button launches the upload process, as shown, below. 

 

 
 

 

Exploratory Data Analysis (EDA) 

Exploratory Data Analysis (EDA) is the process of conducting an initial investigation of the data including the visualization of 

general patterns in the data such as: 

 

▪ the identification of each variable’s discrete (or unique) values by characterizing data using PROC FREQ to display 

frequency distributions. 

 

▪ the production of summary descriptive statistics such as MIN, MAX, RANGE, MEAN, MEDIAN, MODE, STD, and 

VARIANCE using PROC MEANS and PROC UNIVARIATE. 

 

▪ the number of missing values (NMISS) using PROC FORMAT and PROC MEANS. 

 

▪ the display of outliers with BoxPlots using PROC SGPLOT. 
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Task: Characterize Data 

The Characterize Data task allows users to describe data in manners useful for data mining purposes and to better understand 

what is in the data. SAS ODA and SAS Studio provide users with point-and-click capabilities to auto-generate PROC FREQ code 

for data characterization, as shown below. 

 
 

 

Results: 

 



Regression Analysis Made Easy Using SAS® Studio, continued 

 
Page 12 
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Task: Summary Descriptive Statistics 

The Summary Statistics task allows users to summarize or describe the characteristics of a dataset. SAS ODA and SAS Studio 

provide users with point-and-click capabilities to auto-generate PROC MEANS and PROC UNIVARIATE code to produce three 

basic categories of measurements: 1) measures of central tendency, 2) measures of variability (or spread), and 3) frequency 

distributions. 
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Task: Describe Missing Data 

The Describe Missing Data task allows users to examine missing data or missing values in a dataset. SAS ODA and SAS Studio 

provide users with point-and-click capabilities to auto-generate PROC FORMAT, PROC FREQ, and PROC PRINT code to produce 

the number (or frequency) of missing and non-missing data. 

 

 
 

Results: 
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Data Cleaning / Standardization 

Data cleaning is the process of remediating or removing incorrect, corrupted, duplicate, incomplete, or incorrectly formatted 

data in a dataset. 

 

Task: Recode (or Standardize) Values for Status 

The Recode (or Standardize) Values task allows users to remediate or remove incorrect, corrupted, duplicate, incomplete, or 

incorrectly formatted values for the Status variable. SAS ODA and SAS Studio provide users with point-and-click capabilities to 

auto-generate DATA step code to remediate or remove (cleanup) identified Status data issues for improved standardization. 

 

 
 

 
 

 

  



Regression Analysis Made Easy Using SAS® Studio, continued 

 
Page 16 

 

Task: Recode (or Standardize) Values for Sex 

The Recode (or Standardize) Values task allows users to remediate or remove incorrect, corrupted, duplicate, incomplete, or 

incorrectly formatted values for the Sex variable. SAS ODA and SAS Studio provide users with point-and-click capabilities to 

auto-generate DATA step code to remediate or remove (cleanup) identified Sex data issues for improved standardization. 

 

 
 

 
 

Task: Recode (or Standardize) Values for Weight_Status 

The Recode (or Standardize) Values task allows users to remediate or remove incorrect, corrupted, duplicate, incomplete, or 

incorrectly formatted values for the Weight_Status variable. SAS ODA and SAS Studio provide users with point-and-click 

capabilities to auto-generate DATA step code to remediate or remove (cleanup) identified Weight_Status data issues for 

improved standardization. 
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Task: Recode (or Standardize) Values for Weight_Status, continued 

 

 
 

 

Data Transformation Phase 

Data transformation is the process of converting, cleaning, and structuring data from one format to a more usable format to 

enable processing and analysis tasks. Examples of data transformation techniques customarily performed by users include: 

 

▪ Sorting. 

▪ Data Deduplication. 

▪ Data Aggregation. 

▪ Splitting / Consolidating Data. 

▪ Data Cleaning / Smoothing / Standardization. 

▪ Data Normalization. 

▪ Data Filtering. 

▪ Data Concatenation. 

▪ Combining / Integrating Data. 

 

SAS Studio offers users several ways to transform data by producing DATA step and/or PROC SQL syntax. In this paper, we will 

illustrate the point-and-click data transformation techniques to combine two data sets (or tables) together. The following figure 

illustrates merge / join techniques using Venn diagrams, see below. 

 

INNER MERGE / JOIN 

 

LEFT OUTER MERGE / JOIN 

 

RIGHT OUTER MERGE / JOIN 

 

FULL OUTER MERGE / JOIN 

 

Illustration of Merges / Joins using Venn Diagrams 
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Task: Combining (Joining) Tables with All Matching and Non-Matching Rows 

The Combining (or joining) tables with all matching and non-matching rows task allows users to perform a full outer join (or 

merge). SAS ODA and SAS Studio provide users with point-and-click capabilities to auto-generate DATA step or PROC SQL code 

to perform the operation. 
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Task: Combining (Joining) Tables with All Matching and Non-Matching Rows, continued 
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Task: Combining (Joining) Tables with All Matching and Non-Matching Rows, continued 
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Task: Combining (Joining) Tables with All Matching and Non-Matching Rows, continued 
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Task: Combining (Joining) Tables with All Matching and Non-Matching Rows, continued 

 

 
 

 

Results – Snapshot Data Listing of WORK.HEART_HEART_MEDCENTER Dataset: 

The resulting SAS dataset produced from the data transformation phase consists of 5,210 observations and 22 variables and is 

shown below. 
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Correlation Analysis using SAS Studio Point-And-Click Features 

 

Process 

1. Import your data into SAS Studio: First, you'll need to import the data you want to transform into SAS Studio. You can do 

this by clicking on "File" > "Import Data" and selecting the file you want to import. 

 

2. Explore your data: Once you've imported your data, you can explore it by clicking on the data set in the "Explorer" pane. 

This will open the "Data" tab, where you can see the structure of your data, including the variable names, data types, 

and values. 

 

3. Choose "Correlation Analysis": In the "Explorer" panel on the left, click on the "Tasks" tab. And then click on the 

“Correlation Analysis” under the tab of “Statistics”. 

 

4. Specify Variables: In the "Correlation Analysis" task window, you will typically find a section to specify the variables you 

want to analyze. You may have the option to choose variables from your dataset using dropdown menus or by typing in 

the variable names. 

 

5. Set Correlation Method and Options: Depending on the options provided in the task window, you can choose the 

correlation method (e.g., Pearson, Spearman) and other options such as confidence intervals if available. 

 

6. Interpret your results: After pressing the “Run” button, you will produce results including correlation coefficients, p-

values, and other relevant statistics. You can typically view your results in various formats, such as tables and graphs. 

Explore the output to interpret the results of your correlation analysis. 

 

 

Interpretation of Results 

In SAS Studio's output, you will typically see a table that contains correlation coefficients. These coefficients measure the 

strength and direction of the relationship between pairs of variables. 

 

The correlation coefficient can range from -1 to 1: 

 

▪ A value of 1 indicates a perfect positive correlation, meaning that as one variable increases, the other increases 

proportionally. 

 

▪ A value of -1 indicates a perfect negative correlation, meaning that as one variable increases, the other decreases 

proportionally. 

 

▪ A value close to 0 suggests a weak or no linear relationship between the variables. 

 

▪ Correlation does not imply causation. Even if two variables are strongly correlated, it does not mean that changes in one 

variable cause changes in the other. 

 

▪ Outliers in your data can influence correlation coefficients. Examine your data for outliers and consider their impact on 

the analysis. 
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Example of Correlation Analysis and Interpretation: 

In the following example, we chose Height, Diastolic, Smoking, Weight, Systolic, and AgeCHDdiag as our target analysis 

variables, and MRW, AgeAtDeath, AgeAtStart, and Cholesterol as the correlated variables. Therefore, we got total 6 * 4 = 24 

correlation coefficients to interpret. 

 

According to the results, the evident and logical conclusion here is that there exists a robust and positive correlation between 

"AgeCHDdiag" and "AgeAtDeath." This relationship aligns with our intuitive expectations. A positive correlation suggests that 

individuals who are diagnosed with CHD at a later age ("AgeCHDdiag") tend to live longer ("AgeAtDeath"). This could be 

because those diagnosed could have a milder form of CHD or more effective treatments available to them. It may indicate that 

individuals who live longer are more likely to develop CHD at some point in their lives. This is consistent with the idea that as 

people age, they become more susceptible to age-related health conditions, including CHD. 

 

The point-and-click steps are shown below. 

 

 
 

 

 

( Correlation Analysis ) 
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Introduction to Regression Analysis 
In this paper we will primarily focus on two types of regression analysis: Simple Linear Regression and Multiple Linear 

Regression. Regression analysis is a statistical method used for investigating the relationship between one or more independent 

variables and a dependent variable. The dependent variable is the object we are trying to predict, whereas the independent 

variables are the factors that might have an impact on the dependent variable. The primary objective is to model and quantify 

the relationship between the dependent and independent variables and sort out which of these variables have a significant 

impact. We will discuss them individually and provide examples using SAS Studio later. 

 

1.   Simple Linear Regression: Evaluates the relationship between a single independent variable and the dependent 

variable. It produces a linear equation of the form: Y=β0+β1X1+ϵ  where: 

▪ Y is the dependent variable. 

▪ β0 is the y-intercept. 

▪ β1 is the slope, representing the change in Y for a one-unit change in X1. 

▪ X1 is the independent variable. 

▪ ϵ represents the random error. 

 2.   Multiple Linear Regression: Incorporates two or more independent variables. The equation becomes: Y=β0+β1X1+β2

X2+...+βnXn+ϵ 

Each β coefficient indicates the change in the dependent variable for a one-unit change in the corresponding independent 

variable, holding other variables constant. 

In addition to the two key formulas illustrated above, we will include a few more concepts here which are the critical to 

understand for linear regression: 

▪ Coefficient: Represents the change in the dependent variable for a one-unit change in an independent variable. 

▪ R-squared: A statistical measure indicating the proportion of the variance in the dependent variable that's predictable 

from the independent variables. It ranges from 0 to 1, with higher values denoting a better fit. 

▪ p-value: In the context of regression, it assesses the significance of each coefficient. A small p-value (typically ≤ 0.05) 

indicates that you can reject the null hypothesis, suggesting a meaningful addition of the variable to the model. 

 

Assumptions of Simple Linear Regression 

Simple linear regression makes certain assumptions about the data and are presented below: 

1.  Linearity: 

The relationship between the independent variable X and the dependent variable of Y is linear. We can observe a 

straight line through the data points visually. 

 

2.  Homoscedasticity: 

The variance of residual is the same for any value of the independent variable X. This means that the spread of the 

residuals should be roughly the same throughout the range of the independent variable. 

 

3.  Independence: 

Observations in the data set are independent of each other, meaning there is no relationship among observations. 

 

4.  Normality: 

The data is approximately normally distributed. 
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Example: 

Go to Task and Utilities Tasks Graph Histogram. 

Select the desired dataset under DATA and click the plus icon under ROLES. Select the variable from the dataset you wish to 

inspect for normality (we will select Weight here), then click the Run icon, and click RESULTS. 

 

Assumptions of Binary Logistic Regression 

Binary logistic regression makes certain assumptions about the data. The assumptions for binary logistic regression are: 

1. No Multicollinearity: 

Multicollinearity occurs when two or more explanatory variables are highly correlated to each other, such that they do not 

provide unique or independent information in the regression model. If the degree of correlation is high enough between 

variables, it can cause problems when fitting and interpreting the model. 

 

2. Homoscedasticity: 

The variance of the residual is the same for any value of the independent variable X. This means that the spread of the residuals 

should be roughly the same throughout the range of the independent variable. 

 

3. Linearity: 

The relationship between the independent variable X and the dependent variable of Y is linear. We can observe a straight line 

through the data points visually. 

 

4. Large Sample Size: 

A minimum of 10 cases with the least frequent outcome for each explanatory variable is required. 

 

5. No Extreme Outliers: 

The most common way to test for extreme outliers and influential observations in a dataset is to calculate Cook’s distance for 

each observation. If there are indeed outliers, you can choose to (1) remove them, (2) replace them with a value like the mean 

or median, or (3) simply keep them in the model but make a note about this when reporting the regression results.[1] 
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Simple Linear Regression using SAS OnDemand for Academics (ODA) 
 

Background Knowledge 

Simple linear regression is a type of data analysis method that attempts to find some relationships between two variables by 

fitting a linear equation (yi = β0 + β1xi + ϵ) to observed data. Among the two variables, one is the explanatory variable 

(independent variable), the other is response variable (dependent variable). The response variable is the focus of a question in 

a study or experiment. An explanatory variable is one that explains changes in the response variable, and it can be anything that 

might affect that variable.[1] 

 

Typically, the primary purpose of simple linear regression is to create a linear model to predict how independent variables 

affect the dependent variable.[2] And this can be achieved by finding the regression line’s y-intercept and slope in 2D 

coordinate plane, and the model’s R (correlation coefficient) and R-square (coefficient of determination). Luckily, the SAS ODA 

can perform a simple linear regression for datasets and provide the wanted results for the users. Therefore, a step-by-step 

example is illustrated on how to use SAS ODA to perform a simple linear regression with the cleaned and transformed HEART 

dataset for analysis. 

 

SAS ODA Tutorial 

Before fitting the model, it is important to understand the dataset. Therefore, the first step of linear regression analysis is 
summary statistics. As shown below, the Summary Statistics Task can be found under Tasks and Utilities -> Tasks -> Statistics on 
the left side panel. After selecting Summary Statistics, you should select your dataset (step 2) and interested variables (step 3). 
After doing these, your codes for summary statistics are generated.  
 

 

( Summary Statistics Task ) 
 

 

You can select what statistics to be presented under OPTIONS panel, as shown below. 
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( Summary Statistics Options ) 

 

 

It is important to eliminate multicollinearity within independent variables. Using the Scatter Plot Matrix is a very intuitive way 
to discover correlations between variables. As shown below, the Scatter Plot Matrix can be created using the Data Exploration 
Task under Tasks and Utilities -> Tasks -> Statistics. You can select up to 6 continuous variables and 2 classification variables to 
create the plot. After selecting the variables, you can go to the plot panel to select the desired plot. The Scatter Plot Matrix has 
been selected by default.  
 

 
( Summary Statistics Options ) 

 
 
 
As shown below, Diastolic and Systolic are correlated, and Weight and Metropolitan Relative Weight are correlated. Therefore, 
Diastolic or Systolic and Weight or Metropolitan Relative Weight will not be fitted to the model. 
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( Scatter Plot Matrix for Autocorrelation ) 

 

The next step is to create the Linear Regression Model. The model can be created using Linear Regression Task under Tasks and 
Utilities -> Tasks -> Linear Models. As shown below, you need to select your dataset, dependent variable, and independent 
variables. In this scenario, variable Weight is selected as the dependent variable. For independent variables, it is important to 
put continuous variables under the continuous variable panel, even though it is allowed to be selected under the classification 
variable panel. If continuous variables are selected under the classification panel, the model will become unnecessarily 
complex. Since we have known that Weight and MRW, and Diastolic and Systolic are corrected, Systolic and MRW are not 
selected as predictive variables in this model.  
 



Regression Analysis Made Easy Using SAS® Studio, continued 

 
Page 30 

 

 

( Linear Regression Task ) 
 

 

After selecting the variable, you should go to the MODEL panel to select their effect, as shown below. 
 

 
( Selecting Model Effects ) 

 

 

After clicking the run icon to fit the model, it is important to diagnose the model. The table of Parameter Estimates, shown 
below, which shows how much each variable affects the prediction. The p value in the last column shows the significance of 
each variable. As you can see, the variables Cholesterol and Death Cause are not significant to estimate the Weight. Therefore, 
the improved model should eliminate these two variables. 
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( Parameter Estimates ) 

 
 

The Residual vs Predicted Value plot is frequently used to test the assumptions of a linear model. Both assumption of linearity 
and assumption of homoscedasticity can be tested by a Residual vs Predicted Value plot.  
 
As shown below, the residuals make no pattern in the plot and bounce randomly around the 0 line. This implies that the 
assumption of linearity is valid.  
 
The residuals do not change from left to right of the Residual vs Predicted Value plot and roughly form a "horizontal band" 
around the 0 line. This implies that the assumption of homoscedasticity is valid. 
 

 
( Residual vs Predicted Value Plot ) 

 
 
The Q-Q plot, or quantile-quantile plot, can be used to test if the data fit to a theoretical distribution, such as normal 
distribution. We can use it to test if our model fits the normality assumption. As shown below, the points deviate significantly 
from the straight diagonal line and curve upward. This implies the assumption of normality is violated and the data slightly 
skewed to the left.  
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( Q-Q Plot ) 

 
 

Result Interpretation 

Some values in the produced table reveal the regression model’s features and accuracy, and here we will try to explain their 

meanings. First, we can see the number of observations read and used. If these two numbers are different, it implies that some 

observations have unexpected data (like NAN) and it’s better to do the data cleaning beforehand. Secondly, the p-value can be 

found in the “Analysis of Variance” table, the Pr > F. The p-value tells us how likely the linear relationship we observe in the 

sample also exists in the larger population.[3] If p < α, there’s enough evidence to assert the linear relationship exists in the 

larger population. Additionally, the estimated slope and intercept can be found in the Parameter Estimates table, and we can 

also add and subtract the standard error of it to get a corresponding confidence interval. 

 

 
( Useful facts in produced tables ) 

 



Regression Analysis Made Easy Using SAS® Studio, continued 

 
Page 33 

 

If the default options are selected, only one plot will be outputted: the Fit Plot for the response (dependent) variable. We 

present useful information from the plot, and they are illustrated below: 

 

 
( Fitness plots – Best-fit line doesn’t fit)    ( Best-fit line strongly fits ) 

 

To produce alternative plots for additional information, change the selection in the OPTIONS panel. We will explain those 

options’ meaning here: 

 

 
 

( In the OPTIONS panel, decide on the desired output ) 
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There are 3 main aspects to select the produced results: Methods, Statistics, Plots. Methods contains only one choice: the 

confidence level, which is used to compare with the p-value and determines whether the linear regression model is significantly 

explainable. Although the default choice is 95% (as α=0.05), we can select any confidence level we want by using “custom 

value”. There are many choices in the Statistics, like Type Ⅰ or Type Ⅱ squares, predicted values, collinearity analysis. All these 

options will output a statistical table here. However, producing too many or some too long tables will cause unreadable 

outputs. For instance, Selecting Diagnostics is strongly not recommended. This is because regression diagnostics in simple linear 

regression’s objective is to investigate if the calculated model and the assumptions we made about the data and the model, are 

consistent with the recorded data.[4] So, each observation (recorded data) will be analyzed individually with each of the 

model’s predicted value, and this will create a table with rows the same number of observations, which is unbelievably to read 

and get information from it. 

 

In the Plots section, instead, the Diagnostic plots is a better choice to select to examine the distribution of difference between 

predicted value and recorded data, because it produces a residual plot instead of a super-long table. To visualize the linear 

model, there’s many choices in the “Scatter Plots”, and the most convenient default one is the “Fit plot for a single continuous 

variable”. 

 

Categorical Variable Case Tutorial 
The only operation difference between using categorical variable and continuous variable as independent variable in simple 

linear regression is to add the variable to the correct panel, and all other steps are the same. 

 

 
( Select variables from dataset ) 

 

Similarly, we can select intended tables and plots to produce. Because the independent variable is not continuous, it’s 

impossible to produce a fit plot, but an “Observed values by predicted values” is an alternative option. Also, Diagnostic plots are 

recommended to visualize residual distributions. (Note: Select “Display as Panel of plots”, or 9 separate plots will be produced.) 

 

Looking at the results, the most important information to focus on is p-value and the Parameter Estimates. The categorical 

simple linear regression usually selects one level as starting point (in this case the “High”), and other level’s estimates are the 

changes of dependent variable’s value. 

 

https://www.sciencedirect.com/topics/mathematics/regression-analysis
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        (OPTIONS panel, select the intended output)    (Useful facts in produced tables) 
 
 
 

Multiple Linear Regression (MLR) using SAS OnDemand for Academics  
 

Background Knowledge 

Multiple Linear Regression (MLR) is a statistical analysis method that builds upon the foundation of Linear Regression (LR). It 

allows us to simultaneously consider the linear relationship between multiple independent variables and a dependent variable. 

Unlike Simple Linear Regression, which involves only one independent variable, Multiple Linear Regression can include multiple 

independent variables, providing a more accurate representation of complex real-world scenarios. 

 

The key aspects associated with how Multiple Linear Regression extends the capabilities of Linear Regression: 

 

▪ Increased Number of Independent Variables: In Simple Linear Regression, we have only one independent variable to 

predict the dependent variable. However, in Multiple Linear Regression, we can introduce multiple independent 

variables that may have an impact on the dependent variable. This allows us to comprehensively consider the influence 

of multiple factors. 

 

▪ Like Simple Linear Regression, Multiple Linear Regression requires model evaluation to ensure its reliability. Evaluation 

methods include checking the distribution of residuals, using statistical tests to verify the significance of coefficients, and 

employing techniques such as cross-validation to assess the model's generalization performance. 

 

▪ In summary, Multiple Linear Regression is an extended analysis tool that allows us to consider multiple independent 

variables when predicting and explaining the dependent variable. While it requires more data and analysis work than 

Simple Linear Regression, it provides richer insights and more accurate predictive capabilities. 
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Logistic Regression using SAS OnDemand for Academics 
 

Background Knowledge 

Logistic regression is used to estimate the probability of an event occurring or not occurring, based on a combination of 

inputting independent variables.[5] Any other regression methods we’ve shown before are not working when we want to 

estimate probability. This is because the probability is a numerical value between 0 and 1, but linear (simple and multiple) and 

non-linear regressions is one quantitative variable predicting another, which the predicted value can be beyond the interval [0, 

1]. Also, the dependent variable is binary and thus does not have a normal distribution, which is a required assumption for 

linear regression. However, computing the inverse log odds converts all the predicted outputs into the interval [0, 1]. 

 

For all binary logistic regression, the dependent variable is in the Bernoulli distribution with an unknown probability p (of an 

event occurs). The most common link function is “Logit”: 

 

Logit(p)  = ln[p/(1-p)], and take its inverse function to become logit^(-1)(x) = e^x/(1+e^x). 

 

Finally, we can calculate the estimated probability by solving the equation between linear combination of independent 

variables and inverse logit function. 

 

In addition to the estimated probability, the odds ratio is important to consider because it tells us two more stories: 1. The 

increase of a certain independent variable is increasing or decreasing the probability of the selected event happening; 2. How 

large each unit of a certain independent variable can change the probability of the selected event happening. To ensure a 

certain independent variable is significantly impacting the probability of the dependent variable, the confidence interval 

(usually at confidence level 0.05) should not contain 1. 

 

The seemingly complex binary logistic regression can be performed using SAS OnDemand through a point-and-click process, 

and the content like odds ratio and estimated probability can be read from the results. Like other regression methods, a tutorial 

for Logistic Regression is presented. 

 

SAS ODA Tutorial 

We can start a binary logistic regression by clicking the “Tasks and Utilities” in the left sidebar. Then, click “Tasks” → “Linear 

Models” → “Binary Logistic Regression”. Next, browsing and selecting the dataset, as HEART_HMC_JOINED in our example, in 

the DATA panel. 

 

 
( Starting analysis and selecting datasets ) 
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The next step is to select the response variable, the one we want to estimate the probability that one of its levels happen based 

on other variables. We can only choose categorical variables with 2 levels in this place by binary logistic regression’s definition. 

Click the plus sign on the upper right and choose the one we want in the generated list. After that, select the categorical level at 

“Event of interest”, then the model’s output is this level’s estimated occurrence probability. 

 

Below the response variable panel, we need to choose the link function for our model, which is usually the “Logit” function that 

links the estimated probability and the linear combination of independent variables. 

 

 
( Setting response variable and function ) 

 

As we see, there’s a place to select independent (explanatory) variables. Similarly, click the “plus sign” to add variables from the 

generated lists to either categorical or continuous sections. For the “Parameterization of Effects”, there’s no obvious difference 

between the 3 coding manners, so selecting an arbitrary one here is fine and the output will be logically the same. 

 

 
( Setting independent variables ) 
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Next, click the MODEL panel, select “Custom model” in “MODEL EFFECTS” so that we have the maximum level of freedom to 

manipulate our model. Then, click the “Edit” button to add each independent variable as an effect into the model, and after the 

“Model Effects Builder” opens, click “the independent variable’s name” → “Add” → “Intercept” → “OK”. 

 

 

 

                       ( Adjusting model effect )    ( Adding coefficients in effect ) 

 

Moving to the “SELECTION” panel, we can adjust the selection method and significance level here to remove the insignificant 

explanatory variables selected before if their p-value is higher than the significance level.[6] If we want to see how the variables 

are eliminated, just select all options in the “DETAILS” below. 

 

 
( Effect selection ) 
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Move to the “OPTIONS” panel after adjusting the selection and elimination method. Here, like “OPTIONS” in other regression 

analysis, you will need to select the type of tables and plots to see in the output results. The default plots of binary logistic 

regression contain nothing, so if you want to see the “S-shaped” function graph, which is recommended, select “Default and 

additional plots” is necessary. 

 

 
( Results Options ) 

 

Result Interpretation 
The most important value for a binary logistic regression is the odds ratio for each of the independent variables because they 

reveal whether or an independent variable influences the probability of the categorical level that we are interested and in what 

direction it influences. In this SAS Program, all the categorical explanatory variables will be cut into finer variables that each 

new variable represents one of their categories. For example, the “Smoking_Status” variable are separated into 5 new variables 

in the results with each responding to one of the smoking statuses. 

 

 
( Interpreting results: odds ratio in the table ) 
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How to interpret Odds Ratio? Looking at the Table “Odds Ratio Estimates”, the odds ratio for “Smoking_Status Light vs Very 

Heavy” is 12.719, which means “Light” being the smoking status will increase the odds (p/1-p) for the level of interest (in this 

case, being a female). Also, if the estimated odds ratio is smaller than 1, the odds for the level of interest will decrease. Thus, 

we can use odds ratio’s value to determine whether as independent variable increases or decreases the chance the level of 

interest occurs (for discrete independent variable, how its categories change that probability). 

In addition, the confidence limit is also worthy to notice, since if the confidence limits have one greater than 1 and another 

smaller than 1, the confidence interval contains 1, which infers the variable could both increase and decrease the probability. 

So, that variable should be ignored at this significance level. An alternative way to check this is the p-value in the Table 

“Analysis of MLE” to see each variable separately whether their p-value is smaller than the chose significant level. 

 

The effect plot is represented below. Unfortunately, the current SAS Studio can only output one single effect plot using the first 

categorical and the first continuous explanatory variable you selected. If we want to view the effect plots with another 2 

variables’ impact, we must change the sequence of variable selected at the beginning and run the program again. 

 

 
( Logistic regression’s effect plot considering only 2 variables ) 

 

 

Conclusion 

With SAS® OnDemand for Academics (ODA) and SAS Studio, students, users, and SAS learners everywhere can learn SAS 

software’s many powerful features for performing data analysis and other important tasks. Our primary objective for this paper 

is to introduce the ease and simplicity of performing regression analysis by using point-and-click features found in SAS ODA and 

SAS Studio software. We demonstrated SAS Studio’s powerful point-and-click user interface to perform exploratory data 

analysis (EDA), data cleaning, data transformation, and regression analysis using the Navigation Pane consisting of Files and 

Folders, Tasks and Utilities, and Libraries. We also showed the SAS Program window consisting of Code, Log, and Results; data 

access to SAS (SAS7BDAT) datasets; predefined tasks and utilities to perform exploratory data analysis (EDA) to identify and 

better understand missing data, data anomalies, and data trends; and to conduct correlation and regression analysis so an 

organization can achieve greater insights, improve decision-making activities, and predict future events. 
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